Welcome!
Thank you for purchasing the Lorex LIVE video monitor. This user’s guide refers to the following models:

- LW2401
- LW241
- LW2450
- LW2451

Contents
Before you start, make sure you have the contents listed below.

- 1x Video monitor
- 1x Camera
- 1x Video monitor charging cradle
- 1x Camera power adapter
- 1x Video monitor power adapter
- 1x microSD memory card*
- 1x microSD to SD adapter card*
- 1x mini-USB cable
- 1x User’s guide
- 1x Quick start guide
- 1x Driver CD
- 1x Mounting screw kit
- 3x Cable clips

*Optional. Check the contents on your product package.
Safety Instructions

WARNING
This video monitor is compliant with all relevant standards regarding electromagnetic fields and is, when handled as described in the User’s Guide, safe to use. Therefore, always read the instructions in this User’s Guide carefully before using the device.

• Adult assembly is required. Keep small parts away from children when assembling.
• This product is not a toy. Do not allow children to play with it.
• This video monitor is not a substitute for responsible adult supervision.
• Keep the cords out of reach from children.
• Do not cover the video monitor with a towel or blanket.
• Never use extension cords with power adapters.
• Only use the power adapters provided.
• Test the video monitor before use. Become familiar with its functions.
• Do not use the video monitor near water.
• Do not install the video monitor near a heat source.
• Only insert batteries/battery pack of the same type.
• Do not touch the plug contacts with sharp or metal objects.
  Only use the chargers and power adapters provided. Do not use other chargers or power adapters as this may damage the device and battery pack.
• Keep this user’s guide for future reference.

CAUTION
Risk of explosion if battery is replaced by an incorrect type.

• DISPOSE OF OR RECYCLE BATTERIES PROPERLY IN ACCORDANCE WITH APPLICABLE LAWS, which may vary by location.
• Insert batteries with the correct polarity.
• Do not mix new and used batteries.
• Do not mix alkaline, standard, and rechargeable batteries.
• Remove exhausted batteries from the product.
• Keep all batteries away from children.
Using this product as a baby monitor

If you intend to use this wireless video monitor as a baby monitor, we advise you to take the following precautions to avoid possible injury to infants:

• **DO NOT** place baby audio and video camera monitors too close to cribs, bassinets, play yards, and other safe sleep environments for infants.

• **MAKE SURE** to run all power adapter cords where they are unlikely to be tripped over and are out of arms reach of your infant. Keep them at least **3 ft./1m** away.

• **MAKE SURE** baby audio and video camera monitors are on a stable footing so they cannot be easily knocked over.

• Use the included cable clips to keep the power cord out of reach from infants and young children.

**NOTE:** These precautions are important even if your infant is not yet standing or mobile.

**Using the Cable Clips**

- **Option 1:** Thread the extra cable through the cable clip notches.
- **Option 2:** Thread the extra cable through the cable clip notches. Wrap the excess cable around the clip.
- **Option 3:** Wrap the excess cable around the clip.
# Table of Contents

**Video Monitor Overview** ................................................................. 1  
  Using the joystick to navigate menus ........................................... 2  
  Monitor display icons ................................................................. 3  

**Camera Overview** ........................................................................... 4  
  Cameras and Accessories ............................................................... 4  
  LW2401 Camera ................................................................................. 5  
  Pan-Tilt Camera ................................................................................ 6  
    Pan/tilt control ............................................................................. 6  

**Basic Setup** ..................................................................................... 7  
  Step 1 of 2: Powering on the camera ............................................. 7  
  Step 2 of 2: Powering on the video monitor ................................... 7  
  Testing your setup ............................................................................ 8  
  Positioning / wall mounting your camera ...................................... 9  
  Adjusting camera view ................................................................... 10  
  Camera setup .................................................................................. 10  
    Adjusting the camera sensitivity .................................................. 10  
    Adjusting the camera volume ....................................................... 11  
    Turning on the camera night light (LW2401 camera only) .......... 11  
  Video monitor setup ....................................................................... 11  
    Unlocking the video monitor antenna ........................................... 11  
    Reading the power indicator LED ................................................. 11  
  Pairing cameras .............................................................................. 12  
  Sequence view ................................................................................ 13  
  Viewing multiple cameras (Quad view) .......................................... 13  
  Using the talk function ................................................................. 14  
  Music ............................................................................................... 14  
  Turning the video monitor screen on/off ....................................... 15  

**Recording** ....................................................................................... 16  
  Manual recording & auto recording .............................................. 16  
    Manual recording ........................................................................ 17  
    Auto recording ............................................................................ 17  
  Viewing recorded files on the video monitor ............................... 18  
    Viewing video files on a PC ......................................................... 19  
    Viewing video files on a Mac ....................................................... 19  

**Configuring your Video Monitor** ................................................... 20  
  Enabling the Auto-Mute feature .................................................... 20  
  Configuring the Overwrite feature ................................................. 20  
  Changing the date and time ........................................................... 21  
  Adjusting the alarm volume .......................................................... 21
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusting the screen brightness</td>
<td>22</td>
</tr>
<tr>
<td>Adjusting the timer settings</td>
<td>22</td>
</tr>
<tr>
<td>Adjusting the temperature unit of measurement</td>
<td>23</td>
</tr>
<tr>
<td>Configuring the temperature alert range</td>
<td>23</td>
</tr>
<tr>
<td>Erasing the memory card</td>
<td>24</td>
</tr>
<tr>
<td>Restoring default settings</td>
<td>24</td>
</tr>
<tr>
<td>Viewing your Camera Remotely Using Skype</td>
<td>25</td>
</tr>
<tr>
<td>How it works</td>
<td>25</td>
</tr>
<tr>
<td>System requirements</td>
<td>25</td>
</tr>
<tr>
<td>Connecting to Skype on a PC</td>
<td>26</td>
</tr>
<tr>
<td>Connecting to Skype on a Mac</td>
<td>32</td>
</tr>
<tr>
<td>Connecting to Skype on a Mac (continued)</td>
<td>32</td>
</tr>
<tr>
<td>If you do not have a Skype account...</td>
<td>37</td>
</tr>
<tr>
<td>Changing the camera view on Skype</td>
<td>38</td>
</tr>
<tr>
<td>Viewing a camera on your mobile device</td>
<td>39</td>
</tr>
<tr>
<td>Supported apps &amp; devices</td>
<td>39</td>
</tr>
<tr>
<td>Viewing your camera on iPhone</td>
<td>39</td>
</tr>
<tr>
<td>Installing Camera Batteries (LW2401 Camera Only)</td>
<td>41</td>
</tr>
<tr>
<td>Installing non-rechargeable AA batteries</td>
<td>41</td>
</tr>
<tr>
<td>Installing a rechargeable battery pack</td>
<td>41</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>42</td>
</tr>
<tr>
<td>Cleaning and disposal</td>
<td>43</td>
</tr>
<tr>
<td>Cleaning</td>
<td>43</td>
</tr>
<tr>
<td>Disposal of the device</td>
<td>43</td>
</tr>
<tr>
<td>Notices</td>
<td>44</td>
</tr>
<tr>
<td>FCC notice</td>
<td>44</td>
</tr>
<tr>
<td>IC notice</td>
<td>44</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>45</td>
</tr>
<tr>
<td>Troubleshooting (continued)</td>
<td>46</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>47</td>
</tr>
<tr>
<td>Mounting Template (LW2401 Camera Only)</td>
<td>50</td>
</tr>
</tbody>
</table>
Video Monitor Overview

**Video Button**
Press the Video button to turn off the screen. The speaker will remain on.

**Press to access the monitor menu options. Press Menu again to exit.**

**Joystick**
Use to navigate monitor menus. Press down on the joystick to confirm a selection. Use to control the pan/tilt camera.

**Volume Control**
Press + / - to control the volume level.

**Microphone**
Allows you to speak to the person on the camera side when you press the Talk button.

**Antenna Unlock Switch**
Slide the switch to release the receiver antenna.

**Menu Button**
Press to access the monitor menu options. Press Menu again to exit.

**Audio Level Indicator**
Displays the level of sound detected by the camera.

**Power LED**
Glows green to indicate unit is powered on. Blinks when the battery is low.

**Charging Cradle**
Charges the video monitor’s battery.

**Music Buttons**
Press the button once to begin playing a tune. Press the button again to stop the tune.
Press the button to skip to the next tune.

**ON/OFF Switch**
Slide the power switch to the ON position to turn the video monitor on.

**Auto Record Button**
Press to enable auto recording.

**Manual Record Button**
Press to start manual recording.

**Video Button**
Press the Video button to turn off the screen. The speaker will remain on.

**AUTO LED**
Glo ws blue when auto-record is enabled. Blinks when monitor is in Scan mode.

**Audio Level Indicator**
Displays the level of sound detected by the camera.

**Charging Cradle**
Charges the video monitor’s battery.

**Music Buttons**
Press the button once to begin playing a tune. Press the button again to stop the tune.
Press the button to skip to the next tune.

**microSD Card Slot**
Insert a microSD card to record video.

**NOTE:** microSD card and adapter are optional. Check the contents on your product package.
Video Monitor Overview

**Using the joystick to navigate menus**

The joystick allows you to navigate through the video monitor menus or control the camera angle (pan/tilt camera only, see ”Pan/tilt control” on page 6)

**Menu Navigation**

**Step 1:** Press the **Menu** button on the video monitor.

**Step 2:** Move the joystick up, down, left, or right to navigate through the menus.

**Step 3:** Press down on the **OK** button to confirm a selection or press **Menu** to exit menus without saving changes.
## Monitor display icons

The video monitor displays the following icons during normal use.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>No signal between the camera and video monitor.</td>
</tr>
<tr>
<td>🎥📊</td>
<td>Full signal between the camera and video monitor.</td>
</tr>
<tr>
<td>🕒</td>
<td>Timer is enabled.</td>
</tr>
<tr>
<td>🔇</td>
<td>The video monitor audio is muted.</td>
</tr>
<tr>
<td>💡</td>
<td>The camera night light is on (LW2401 camera only).</td>
</tr>
<tr>
<td>📇💬</td>
<td>Two-way talk is enabled. You can now speak into the video monitor to talk to the camera. Release the Talk button on the video monitor to listen to audio from the camera.</td>
</tr>
<tr>
<td>SD</td>
<td>An SD card is inserted in the video monitor.</td>
</tr>
<tr>
<td>🟡</td>
<td>A new file has been recorded onto the microSD card. Note that this icon is yellow.</td>
</tr>
<tr>
<td>🔴</td>
<td>The microSD card is full. Note that this icon is red.</td>
</tr>
<tr>
<td>CAM1</td>
<td>Indicates what channel the video monitor is on.</td>
</tr>
<tr>
<td>REC</td>
<td>Indicates that the video monitor is recording video. The file name appears beside the REC icon.</td>
</tr>
<tr>
<td>OW</td>
<td>Overwrite is enabled. This means the video monitor will overwrite old video files once the card is full. For details, see &quot;Configuring the Overwrite feature&quot; on page 20.</td>
</tr>
<tr>
<td>Charge Battery</td>
<td>The video monitor battery is low.</td>
</tr>
<tr>
<td>Charge Camera</td>
<td>The camera batteries are low (LW2401 camera only). For details on installing batteries in the camera, see &quot;Installing Camera Batteries (LW2401 Camera Only)&quot; on page 41.</td>
</tr>
<tr>
<td>OUT OF RANGE</td>
<td>The camera is out of range. Move the camera closer to the video monitor.</td>
</tr>
</tbody>
</table>
Camera Overview

Cameras and Accessories

The camera included with your system differs depending on the model number of your device. The cameras and accessories shown below are all compatible with the video monitor system and are available from www.lorextechnology.com. The video monitor supports up to 4 cameras and can support a mix of pan/tilt, regular, and indoor/outdoor cameras.

**LW2401AC1 Camera**
Accessory #: LW2401AC1
- Wall mountable
- Includes night light
- Takes AA batteries (optional, not included)* or rechargeable battery pack (optional, not included)*

For instructions, see "LW2401 Camera" on page 5.

**LW2451AC1 Pan/Tilt Camera**
Accessory #: LW2451AC1
- Adjustable pan/tilt using the video monitor joystick
- Wall mount available
- AC power only

For instructions, see "Pan-Tilt Camera" on page 6.

**LW2401AC2 Indoor/Outdoor Camera**
Accessory #: LW2401AC2
- Wall/ceiling mountable
- Motion detector for motion recording/alarms**
- No volume control, audio alarms, or alarm sensitivity control
- No temperature sensor***
- AC power only

For installation instructions, see the LW2401AC2 Quick Start Guide.

**Charging Cradle for Video Monitor**
Accessory #: ACC241CRDL

**Rechargeable Battery for LW2401AC1 Camera**
Accessory #: ACC2401BATT

**Wall Mount for LW2451AC1 Camera****
Accessory #: ACCMNT2451

* For instructions on installing batteries, see "Installing Camera Batteries (LW2401 Camera Only)" on page 41.
** Motion detector uses Auto Record feature for motion recording. For details, see "Auto recording" on page 17.
*** When selected, temperature reading on monitor is permanently set to 68°F / 20°C.
**** Appearance may not be exactly as shown.
**LW2401 Camera**

- **Infrared LEDS**
  Infrared (IR) LEDs that allow you to see in the dark.

- **Speaker**
  The speaker allows you to hear the person speaking into the video monitor.

- **Microphone**

- **IR Light Sensor**
  Detects the level of light in the room to trigger night vision.

- **Night Light Button**
  Press to activate the camera’s night light.

- **Temperature Sensor**
  Detects the room’s ambient temperature*.

- **Power Port (DC5V)**
  Connect the power adapter to the Power Port.

- **Power LED**
  Glows to indicate camera is on. Blinks when battery is low.

- **Sensitivity Dial**
  Adjust the audio level that will trigger an alert on the video monitor.

- **Volume Dial**
  Adjusts the speaker volume.

- **Pair Button**
  Press the Pair button during the pairing process with the video monitor.

- **Battery Charging Indicator**
  Glows to indicate battery is charging. This requires a rechargeable battery pack. For details, see “Installing Camera Batteries (LW2401 Camera Only)” on page 41.

* Avoid placing the camera in direct sunlight, as this will cause the temperature sensor to detect the wrong temperature.
Camera Overview

Pan-Tilt Camera

Infrared LEDs
Infrared (IR) LEDs that allow you to see in the dark.

Temperature Sensor
Detects the room’s ambient temperature*.

*Avoid placing the camera in direct sunlight, as this will cause the temperature sensor to detect the wrong temperature.

Power Switch
Turns the camera on and off.

Pair Button
Use a pin or thin object to press the Pair button during the pairing process with the video monitor.

Microphone
The speaker allows you to hear the person speaking into the video monitor.

Light Sensor
Detects the level of light in the room to trigger night vision.

Power Port (DC5V)
Connect the power adapter to the Power Port.

Volume Dial
Adjusts the speaker volume.

Sensitivity Dial
Adjust the audio level that will trigger an alert on the video monitor.

Infrared LEDs
Infrared (IR) LEDs that allow you to see in the dark.

NOTE: You must be in full-screen view to adjust the angle. If the monitor is in Quad view (i.e. showing multiple cameras), press **SEQ** and then **CAM** to return to full-screen view. If the monitor is in Sequence view (i.e. switching between cameras), press **CAM** to exit Sequence view.

1. Select the channel the pan/tilt camera is connected to. Ensure you are in full-screen view.
2. Use the joystick on the video monitor to control the camera.

Temperature Sensor
Detects the room’s ambient temperature*.

*Avoid placing the camera in direct sunlight, as this will cause the temperature sensor to detect the wrong temperature.

Pair Button
Use a pin or thin object to press the Pair button during the pairing process with the video monitor.

Microphone
The speaker allows you to hear the person speaking into the video monitor.

Power Port (DC5V)
Connect the power adapter to the Power Port.

Volume Dial
Adjusts the speaker volume.

Sensitivity Dial
Adjust the audio level that will trigger an alert on the video monitor.

Infrared LEDs
Infrared (IR) LEDs that allow you to see in the dark.

NOTE: You must be in full-screen view to adjust the angle. If the monitor is in Quad view (i.e. showing multiple cameras), press **SEQ** and then **CAM** to return to full-screen view. If the monitor is in Sequence view (i.e. switching between cameras), press **CAM** to exit Sequence view.

1. Select the channel the pan/tilt camera is connected to. Ensure you are in full-screen view.
2. Use the joystick on the video monitor to control the camera.
Basic Setup

Step 1 of 2: Powering on the camera

1. Connect the power adapter to the DC5V port on the camera. Connect the other end to a power outlet.

2. Slide the power switch to the ON position.

**LW2401 camera**

OPTIONAL (LW2401 camera only): To install batteries in the camera, see “Installing Camera Batteries (LW2401 Camera Only)” on page 41.

**Pan-tilt camera**

Step 2 of 2: Powering on the video monitor

1. Connect the power adapter to a power outlet and to the DC5V port on the video monitor or charging cradle (ensure the video monitor firmly rests on the cradle). The video monitor’s charging LED indicator glows red to indicate charging is in progress. The charging LED glows green when the video monitor is fully charged.

**NOTE:** It requires 6 hours to fully charge the battery.
2 Slide the power switch to **ON**. The video monitor will automatically scan for cameras in range.

**Using the charging cradle**

![Charging Cradle Diagram]

**Testing your setup**

It is recommended that you test your camera setup before permanent installation so that you get the best picture and sound quality from your video monitor.

**Test the camera and video monitor reception:**

1. Place the camera and video monitor in two different rooms.
2. Have one person monitor the signal strength on the video monitor.
3. If the signal strength is low, have a second person move the camera to different locations in the room to find the best placement location.

**Test the camera volume level:**

1. Have a person with the video monitor press and hold the **TALK** button to confirm the camera volume level. Have the other person adjust the volume dial on the camera as required.
2. Have the person near the camera speak into it to test the sound quality on the video monitor. The person holding the video monitor can determine if the camera needs to move to a different location in the room for better sound clarity.
Positioning / wall mounting your camera

- Keep cables and wires at least 3 feet (1 meter) away from infants or young children.
- Use the cable clips to keep the power cords out of reach from young children and infants.
- Determine the camera position that will give you the best view before permanently mounting the camera. Ensure the power cable is long enough to power the camera.

To wall mount your camera (LW2401 camera only)*:

1. Mark the screw holes using the template on page 50.
2. Drill the holes in the wall.
3. Insert the screw anchors (included) into the hole. Lightly tap the anchor into the hole with the hammer until the anchor is flush with the wall.
4. Tighten the screw into the anchor, leaving 1/4” of the screw exposed.
5. Rotate the base of the camera as shown in “Adjusting camera view” on page 10.
6. Slide the back of the camera onto the screws and pull down to secure the camera in place.
7. Connect the power adapter to the camera.
8. Use the cable clips to keep the cables out of reach from infants and young children.

* An optional wall-mount accessory is available for the pan/tilt camera from www.lorextechnology.com [accessory # ACCMNT2451]. For wall/ceiling mounting instructions for LW2401AC2, see the LW2401AC2 Quick Start Guide.
Basic Setup

**Adjusting camera view**
Adjust the camera to achieve the optimal viewing position.

**LW2401 Camera**

**Table top adjustment**

**Wall mount Adjustment**

- **Step 1: Rotate Camera**
  Rotate the camera to the right.

- **Step 2: Fold camera base**
  Fold the camera base towards the back of the camera.

**Pan/tilt camera**
Use the pan/tilt controls to adjust the camera view. For instructions, see “Pan/tilt control” on page 6.

**Camera setup**

**LW2401 Camera**

- **Night Light Button**
  (LW2401 Camera Only)
  Press the Night Light button to turn the camera night light on or off.

- **Adjust the audio sensitivity**
  Adjust the audio level that will trigger an alert on the video monitor.

- **Adjust the camera volume**
  Adjust the speaker volume.

**Pan/tilt Camera**

**Adjusting the camera sensitivity**
The camera’s Sensitivity dial allows you to adjust the microphone sensitivity level for triggering an alert on the video monitor.
To adjust the camera’s sensitivity level:
- Scroll the Sensitivity dial to increase camera sensitivity (i.e. softer noises trigger the camera) or reduce sensitivity (i.e. louder noises trigger the camera).

Adjusting the camera volume
The camera’s speaker volume can be adjusted to the desired level. Scroll the Volume dial to increase or decrease the camera volume.

Turning on the camera night light (LW2401 camera only)
- Press the night light button on the top of the camera to turn the night light on or off. The night light button glows when the night light is on and the monitor displays the ☀ icon to indicate the camera night light is on.

Video monitor setup

Unlocking the video monitor antenna
The video monitor has a built-in antenna that improves signal range. It is recommended that you extend antenna for optimal performance.

To unlock the monitor antenna:
- Slide the lock button to the right.

Reading the power indicator LED
The power indicator LED glows green when the monitor is powered on. When the battery is low, the power LED blinks.
**Pairing cameras**

The camera included with the video monitor has already been paired up with the video monitor. If for any reason your monitor and camera are not paired up, or you wish to add additional cameras, follow the directions below.

**To pair a camera to the video monitor:**

1. Place the camera and video monitor 12 inches apart. Turn on the camera first and then the video monitor.

2. Press the **Menu** button on the monitor, then select **Pairing** and press the **OK** button.

3. Select an available channel, and press the **OK** button.
   - **NOTE:** By default, the camera included with the system is paired to channel 1.

4. Press the **PAIR** button on the camera within 30 seconds. (Pan/tilt camera) Use a pin, paper clip, or another thin object to press the PAIR button.
   - **•** You should immediately see video from the camera on the video monitor.

5. **OPTIONAL:** To pair multiple cameras, repeat steps 2~4, selecting a different channel in the pairing menu.
   - **NOTE:** You can add a maximum of four (4) wireless cameras to the video monitor. Add-on cameras are available from [www.lorextechnology.com](http://www.lorextechnology.com) (accessory # LW2401AC1, LW2451AC1, LW2401AC2).
**Sequence view**

In Sequence view, the monitor switches between paired cameras every six seconds. For example, the monitor displays channel 1 for six seconds, then channel 2 for six seconds and so on. The monitor only switches to channels that are paired with a camera.

**To enable Sequence view:**
- Press the **SEQ/Quad** button once to enter Sequence view.

**To exit Sequence view:**
- Press the **CAM** button.

---

**Viewing multiple cameras (Quad view)**

You can view all of the paired cameras in Quad view. The video monitor supports a maximum of four cameras.

**NOTE:** Audio monitoring is not available in Quad view.

**To view multiple cameras in Quad view:**
- Press the **SEQ/Quad** button twice on the video monitor.

**To exit Quad view:**
- Press the **SEQ/Quad** button, and then press **CAM** to exit Quad view and return to single-camera view.
Using the talk function
The talk function allows you to speak into the video monitor and have the camera output your voice. The camera also has a built-in microphone, which allows the person to speak into the camera.

Hello
Talk and listen (Two-way communication)
LW2401 camera shown

To use the talk function:
1 Adjust the volume on the camera and video monitor to the desired level.
2 Press and hold the Talk button on the video monitor and begin speaking. Release the Talk button when you are finished.
   NOTE: You must release the Talk button on the video monitor in order to listen to the audio from the camera.

   NOTE: The talk function does not work in Quad view.

Music
The music feature allows the camera to play pre-loaded tunes.

To use the tune feature:
• Press the ▶/■ button to begin playing a tune on the camera and video monitor.
• Press the ▶/■ button again to stop the tune.
• Press the ▶ button to skip to the next tune. The song title appears on-screen.
   NOTE: Music is not available in Quad view.
Using Scan mode

Scan mode temporarily turns off the video monitor, and waits for a camera to detect a noise. Once one of the cameras detect sounds, the video monitor automatically turns on, and beeps to notify you. This feature is especially useful if you have multiple cameras, and only want to view the camera that detects a sound (e.g. infant crying).

To enable Scan mode:
• Press the Scan button.

To disable the Scan mode:
• Press the Scan button to turn off Scan mode.

NOTE: The first camera to detect a sound will trigger the video monitor to turn on. After several seconds, the monitor turns off and begins monitoring the cameras again.

Turning the video monitor screen on/off

Turning off the video monitor screen allows you to listen to audio from the camera, while the video monitor screen is off. For example, if you want to monitor a baby’s room at night while you sleep, you can turn off the video monitor screen to conserve power, and at the same time listen to the camera audio.

To turn the video monitor screen on/off:
• Press the Video button to turn the screen off.
• Press the Video button again to turn the screen on.
Recording

**NOTE:** A microSD card is required to enable recording.

This system is capable of recording video on a microSD card. Use the table below to help you estimate recording times on various sizes of microSD cards.

<table>
<thead>
<tr>
<th>microSD Card Capacity</th>
<th>With movement (e.g. drive-by cars)</th>
<th>With limited movement (e.g. empty room)</th>
</tr>
</thead>
<tbody>
<tr>
<td>512 MB</td>
<td>55 minutes</td>
<td>1 hour and 50 minutes</td>
</tr>
<tr>
<td>1 GB</td>
<td>1 hour and 45 minutes</td>
<td>2 hours and 50 minutes</td>
</tr>
<tr>
<td>2 GB</td>
<td>3 hours and 50 minutes</td>
<td>5 hours and 50 minutes</td>
</tr>
<tr>
<td>4 GB</td>
<td>7 hours and 40 minutes</td>
<td>12 hours</td>
</tr>
<tr>
<td>8 GB</td>
<td>15 hours and 30 minutes</td>
<td>23 hours and 40 minutes</td>
</tr>
<tr>
<td>16 GB</td>
<td>29 hours and 10 minutes</td>
<td>45 hours and 50 minutes</td>
</tr>
<tr>
<td>32 GB</td>
<td>57 hours and 40 minutes</td>
<td>89 hours and 25 minutes</td>
</tr>
</tbody>
</table>

**NOTE:** Estimated recording times based on tests using Kingston™ brand microSD cards. There may be a slight variation when using different brands of memory. A scene with more activity requires more storage space.

**Manual recording & auto recording**

**Prerequisite:**

- Insert a microSD card into the microSD slot in the video monitor.

**NOTE:** The video monitor supports microSD cards up to 32 GB (gigabytes).
Manual recording

Manual recording allows you to record video by pressing the record button on the video monitor. Manual recording may be useful if you want to quickly record an event to your video monitor while you are watching it.

**NOTE:** It is recommended to set the date and time before using the recording function. For details on setting the date and time, see "Changing the date and time" on page 21.

To start manual recording:

1. Press the **M** button on top of the video monitor. The **REC** icon, followed by the file name (e.g. 113711-1.AVI) appears on the screen to indicate recording is in progress.

2. Press the **M** button again to stop recording. The yellow file icon ( ) appears to indicate a new recording is ready for viewing.

Auto recording

Auto Recording allows the video monitor to record only when the camera detects a sound or motion (LW2401AC2 only). For example, if you are monitoring a sleeping baby, the video monitor will not record until the baby cries (ensure you set the appropriate sensitivity level).

- **LW2401AC2 Only:** Auto Recording is triggered by the built in motion detector in the camera. The camera does not support audio alarms or audio triggered recording.

**Prerequisites:**

- Adjust the sensitivity level on the camera to the desired level. Higher sensitivity means the camera will be more sensitive to noise. This means that the slightest sound will cause the video monitor to record. There is no sensitivity control on the LW2401AC2 camera.

To enable Auto Recording:

- Press the **A** button on top of the video monitor. The AUTO LED glows blue. When a camera detects a sound or motion (LW2401AC2 only), the video monitor begins to record. The **REC** icon, followed by the file name (i.e. 113711-1.AVI) appears on screen to indicate a new recording. The yellow file icon appears to indicate a new recording is ready for viewing.

**NOTE:** The recording time after a camera triggers the video monitor, is between 5~30 seconds. The duration of the recording can be set in the Trigger menu [Menu→Record→Audio Trigger]. This also applies to motion recording using the LW2401AC2 camera.

**NOTE:** The maximum recording time during auto recording is 10 consecutive minutes. For example, if there is constant noise, the video monitor will record a maximum of 10 minutes.
Viewing recorded files on the video monitor

There are two ways that you can view the recorded video files on the microSD memory card: through the video monitor or on your computer.

**NOTE:** Video files are saved in .avi format.

**To view video files through the video monitor:**

1. Press the **OK** button on the video monitor (press down on the joystick). The File List menu opens.

2. Press **OK** to open the VIDEO folder.

3. Select the desired folder and press the **OK** button.
   **NOTE:** The folders are named by the year, month, and date. For example, a folder named **110204** means that the folder was created in **2011**, February (**02**), on the **4th**.

4. Select the video file you wish to view, and press the **OK** button to begin playback.

![Video Playback Controls](image)

- Press right on the joystick repeatedly to increase playback speed [2x, 4x, 8x]
- Press left on the joystick to reduce playback speed [-2x, -4x, -8x]
Viewing video files on a PC

1 Remove the memory card.

2 Insert the microSD card into a memory card reader (not included).
   **NOTE:** If required, use the included SD card adapter to convert the microSD card to SD/HCSD memory card format.

3 When the AutoPlay menu appears, click on **Open folder to view files**.

4 Double-click the **VIDEO** folder, then select the sub-folder you want to open.
   **NOTE:** The folders are named by the year, month, and date. For example, a folder named **110204** means that the folder was created in **2011**, February (**02**), on the **4th**.

5 Double-click the desired video file to begin playback.

Viewing video files on a Mac

1 Insert the microSD card into a memory card reader. If required, use the included SD card adapter.

2 The memory card automatically appears on the desktop.

3 Double-click the USB icon [ ] on your desktop to view the microSD contents.

4 Double-click the **VIDEO** folder, then select the sub-folder you want to open.
Enabling the Auto-Mute feature
The Auto-Mute feature eliminates white noise when monitoring a room. The Auto-Mute feature works by muting the video monitor when the camera detects no audible noise. Once the camera detects a sound, the video monitor plays sound again.

To enable Auto-Mute:
1. Press the Menu button on the video monitor.
2. Select Auto Mute ( ) using the joystick and press OK.
3. Select ON to enable auto mute.
4. Press the OK button (press down on the joystick) to save your settings.

Configuring the Overwrite feature
The Overwrite feature allows the video monitor to continuously record on the microSD card. When the microSD card is full, the video recordings overwrite the first recorded video entry (first in first out).

To enable overwrite:
1. Press the Menu button on the video monitor.
2. Select Record ( ) and press OK.
3. Select File Overwrite and press OK.
4. Select Yes to enable overwrite or select No to disable overwrite.
5. Press the OK button to save your settings.
Changing the date and time

To adjust the video monitor’s date and time:
1. Press the Menu button on the video monitor.

2. Select Settings [ ] and then press the OK button.

3. Select Date & Time and then press the OK button.

4. Use the joystick to configure the Year, Month, and Date.
   • Press up/down on the joystick to adjust the values.
   • Press left/right to move between the year, month, and date.

5. Press the OK button to save your changes, or press Menu to exit the menu without saving your changes.

Adjusting the alarm volume

The video monitor ‘beeps’ when the camera detects audio triggers (e.g. a loud noise) or motion triggers (LW2401AC2 only). You can adjust how loud the video monitor beeps when the alarm triggers.

This is useful if you want to monitor activity in an area, but cannot keep your eyes on the video monitor.

To change the video alarm volume:
1. Press the Menu button on the video monitor.

2. Select Settings [ ] and then press the OK button.

3. Select Alarm Volume and then press the OK button.

4. Press left and right on the joystick to adjust the alarm volume.

5. Press the OK button to save your settings.

NOTE: To disable the alarm ‘beep’ turn the volume all the way down.
**Adjusting the screen brightness**

To adjust screen brightness:
1. Press the **Menu** button on the video monitor.

2. Select **Settings** ( ) and then press the **OK** button.

3. Select **Brightness** and then press the **OK** button.

4. Press left and right on the joystick to adjust the screen brightness.

5. Press the **OK** button to save your settings.

---

**Adjusting the timer settings**

The timer allows the video monitor to beep after a set duration. If the monitor is used as a baby monitor, the timer can help remind you when it is time to feed the baby.

To enable the Timer:
1. Press the **Menu** button on the video monitor.

2. Select **Settings** ( ) and then press the **OK** button.

3. Select **Timer** and then press the **OK** button.

4. Enter the timer duration using the joystick. Press left / right to navigate the values. Press up/down to adjust the values.

   **NOTE:** Timer duration is represented as (Hours: Minutes)

5. Select **ON** and then press the **OK** button to save your settings. When the timer duration ends, an alarm goes off and the timer resets until it is manually disabled.
Adjusting the temperature unit of measurement

The camera has a built-in temperature sensor. You can change the video monitor to display temperature in Fahrenheit (F) or Celsius (C).

To change the unit of measurement:
1. Press the Menu button on the video monitor.
2. Select Settings ( ) and press the OK button.
4. Select either C for Celsius or F for Fahrenheit.
5. Press the OK button to save your settings.

Configuring the temperature alert range

You can configure the video monitor to alert you through alarm beeps, when the temperature goes above or below the set temperature range.

NOTE: Temperature sensor is accurate within 3°F/1°C.

NOTE: The LW2401AC2 accessory camera does not have a temperature sensor. When this camera is selected, the temperature reading is permanently set to 68°F/20°C.

To configure the temperature alert range:
1. Press the Menu button on the video monitor.
2. Select Settings ( ) and then press the OK button.
3. Select Temp. Alert and then press the OK button.
4. Using the Joystick, press up/down to change selection, left/right to adjust the values:
   - Beside Low Temperature, enter the lowest room temperature threshold.
   - Beside High Temperature, enter the highest room temperature threshold.
5. Select the ON button and then press OK.
Erasing the memory card
Once you erase the memory card, the video will be deleted permanently.

To erase the memory card:
1. Press the Menu button on the video monitor.
2. Select Settings ( ) and then press the OK button.
3. Select Format memory and then press the OK button.
4. Select Yes and then press the OK button to erase the memory card.
   • The message “Format OK” appears to confirm that the card has been erased.

Restoring default settings
Restoring your video monitor settings returns any setting changes to factory default settings

To restore the video monitor factory defaults:
1. Press the Menu button on the video monitor.
2. Select Settings ( ) and then press the OK button.
3. Select Factory Reset and then press the OK button.
4. Select Yes, and then press the OK button.
Viewing your Camera Remotely Using Skype

Connecting to your video monitor through Skype is a convenient and free* method to view your camera from anywhere with an internet connection.

**NOTE:** When remotely connecting to your video monitor using Skype, recording, audio monitoring, and pan/tilt controls are disabled.

**How it works**

Your computer connects to the Skype server. The Skype server is connected to your home computer. Your home computer connects to the video monitor, which captures video from the camera.

**System requirements**

**iPhone, iPad, iPod Touch Requirements**
- Skype for iPhone v. 3.0 and above
- Skype for iPad v. 3.5 and above
- iPhone 4S/4/3GS, iPad (1st generation and above), iPod touch (3rd generation and above)
- iOS 4.0 and above

For the latest device compatibility list, visit www.lorextechnology.com

**PC requirements**
- Skype for Windows v. 4.2 and above
- Windows XP SP2/Vista/Windows 7
- 1 Ghz or greater processor

For instructions, see “Connecting to Skype on a PC” on page 26.

**Mac requirements**
- Skype for Mac OS v. 5.3 and above
- Mac OS v. 10.5.8 and above
- 1 GHz or higher Intel processor
- PowerPC™ not supported

For instructions, see “Connecting to Skype on a Mac” on page 32.

**Disclaimers**

You must have a high-speed internet connection to use the video function on Skype. Traffic congestion may result in choppy video.

**Mobile Data Charges**

When using a mobile cellular network, data charges may apply. Check with your provider for details.

*Computer to computer

For Skype related support, visit https://support.skype.com/
Connecting to Skype on a PC

Step 1 of 6: Installing the camera driver for PC

You will need to install the camera drivers located on the software CD (included) or available as a free download from www.lorextechnology.com.

To install the camera drivers:

1. Insert the software CD into your computer. An Autoplay window opens.
2. Click Run Lorex.exe.
3. Click the USB Driver button, and then click USB Driver. The driver appears on your desktop.
4. Click the button to close the window.
5. Double-click the Usbdriver-PC icon on your desktop.
6. Follow the on-screen instructions to complete the driver installation.
Step 2 of 6: Connecting the video monitor to the PC

1. Turn on the camera first, then the video monitor. **Make sure you can see a video image on channel 1.**
   
   **NOTE:** Pair the camera that is most important for you to view remotely to Channel 1. For instructions on how to pair cameras, see “Pairing cameras” on page 12.

2. Connect the mini-USB cable (included) to your video monitor and into the computer's USB port. The video monitor displays the following: "USB PC CAMERA MODE"

   ![mini-USB cable connection](image)

Step 3 of 6: Creating a Skype account

A Skype account allows you to connect to your camera through the Skype service. Skype is a service that allows users to make voice calls and video calls to anywhere in the world.

In order to connect to your video monitor using Skype, you will need **two accounts**—one for the camera (e.g. Lorex Camera) and one for yourself (e.g. Tom Smith).

**NOTE:** The Skype illustrations and instructions below serve as a guideline only. Skype may change their website / product interface without prior notice.

**If you do not have a Skype account**

See “If you do not have a Skype account...” on page 37.

**If you have an existing Skype account (PC)**

You will have to create a separate account for your camera. Follow the instructions below.

1. Launch Skype. If you are connected to Skype, click **Skype→Sign Out.**

2. From the Skype Login window, click **Create a new account.**
Follow the on-screen instructions to create a new account. Upon login, the Setting up Skype wizard starts. Click **Continue**. Under Video, you will see an image from the camera. If no image appears, make sure the monitor is connected to the computer via the USB cable.

**NOTE:** If you can see an image from a webcam that is already connected, select **Wireless Monitoring System** from the drop-down menu.

**NOTE:** If the Setting up Skype wizard does not run, click **Tools → Options → Video Settings**. Make sure you can see video in the window. Click **Save** to exit. If the image is from an already connected webcam, select **Wireless Monitoring System** under **Select Webcam**.

4. Click **Continue**.

5. In the next page, click **Add later** to not include a profile picture for the camera’s Skype account, or click **Continue** and follow the instructions to add a profile picture for the camera’s Skype account.

6. Click **Start using Skype**.
Step 4 of 6: Configuring Skype

7 Click on Tools→Options.

8 Click the Calls button [📱].

9 Click the Show advanced options button.

10 Under Allow calls from..., select people in my Contact list only. This will prevent the device from accepting Skype calls from anyone who is not in the contact list for its account.

NOTE: You may also select anyone, which will allow anyone with a Skype account to call the device and access your camera. This setting is not recommended.
11 Check **Answer incoming calls automatically** and **Start my video automatically when I am in a call**. Click **Save**.

![Making changes to call settings](image1)

**Step 5 of 6: Send a contact request**
Next, you have to send a friend request to your personal account (e.g. Tom Smith).

1 **Click the Add a contact button**.

![Clicking the add a contact button](image2)

2 **Search for the name of your personal account** (e.g. Tom Smith), and then click the **Add** button.
Click **Send Request**.

Step 6 of 6: Test the connection

**NOTE:** This step requires you to log in to Skype from a **different computer** or **compatible mobile device**.

1. Log in to your personal account (e.g. Tom Smith).
2. A "new contact" pop-up appears. Click the new contact request icon that appears on the bottom-right corner of the window.
3. Click the **Add to Contacts** button to add the camera to your contact list.
4 From the contact list, right-click on your camera’s account name (e.g. Lorex Camera), and click **Call**. The video call begins automatically. Please allow around 15 to 25 seconds for the video connection to be established.

**NOTE:** Video may appear pixelated immediately after connecting. It should improve within a few seconds, depending on your Internet connection.

**Connecting to Skype on a Mac**

**Step 1 of 6: Installing the camera driver for Mac OS**
You will need to install the camera drivers included on the software CD (included).

1 Insert the software CD into your computer. The Lorex CD icon appears on your desktop.

2 Double-click the **Lorex CD** icon on your desktop.

3 Double-click the **Mac** folder.

4 Double-click the **SD Series Mac Driver.zip** file to extract the installer. The installer is saved to your Downloads folder and your downloads folder opens automatically.

5 Double-click the **SD Series Mac Driver** folder and then double-click the **WirelessCameraMacDriverSuiteInstaller (.pkg)** file.

6 Follow the on-screen instructions to install.

**Step 2 of 6: Connecting the video monitor or receiver to your computer**

1 Turn on your camera first, and then turn on your video monitor or receiver. **Make sure you can see a video image on Channel 1.**

**NOTE:** Pair the camera that is most important for you to view remotely to Channel 1. For instructions on how to pair cameras, see “Pairing cameras” on page 12.
2 Connect the mini-USB cable (included) from the USB port on your video monitor or receiver to an available USB port on your computer. "USB PC CAMERA MODE" appears on the screen.

Step 3 of 6: Creating a Skype account

A Skype account allows you to connect to your camera through the Skype service. Skype is a service that allows users to make voice and video calls to anywhere in the world.

In order to connect to your video monitor using Skype, you will need two accounts—one for the camera (e.g. Lorex Camera) and one for yourself (e.g. Tom Smith).

NOTE: The Skype illustrations and instructions below serve as a guideline only. Skype may change their website / product interface without prior notice.

If you do not have an existing Skype account:
See "If you do not have a Skype account..." on page 37.

If you have an existing Skype account [Mac]:
You have to create a separate account for your camera. Follow the instructions below.

1 Launch Skype. If you are already connected to Skype, click **File→Sign Out**.

2 Click **Create New Account**.

3 Follow the on-screen instructions to create a new account.
Step 4 of 6: Configuring Skype

1 Upon login, click Skype > Preferences. Select the Audio/Video tab.

2 Under Camera, select Wireless Monitoring System if it is not already selected. You will see live video from your camera if your device is connected.
   - If the video area is black, check to see if your camera is on and is paired to Channel 1. Also check to make sure your video monitor is connected to your computer.
   
   **NOTE:** When connecting or reconnecting your video monitor, you must close the Preferences window and re-open it to the Audio/Video tab to test the video connection.

3 Select the Calls tab.

4 Under Incoming Calls, select Answer Automatically.

5 Click Configure.
6 Select **Answer automatically with video**. Click **Done**.

7 Select the **Privacy** tab.

8 Under **Allow calls from**, select **Contacts**. This will prevent the device from accepting Skype calls from anyone who is not in the contact list for its account.

**NOTE**: You may also select **Anyone**, which will allow anyone with a Skype account to call the device and access your camera. This setting is not recommended.

9 Close the Preferences window to return to the main Skype window.

**Step 5 of 6: Send a contact request**
Next, you have to send a friend request to your personal Skype account (e.g. Tom Smith).

1 From the main Skype window, click **Contacts** then click **Add Contact**.
2  Under Add Contact, enter the Skype account name (e.g. Tom Smith) or email address for your personal Skype account. Click Find. Your personal Skype account should appear below the search bar.

3  Next to your personal Skype account, click 📧 and then click Send to send the contact request.

**Step 6 of 6: Test the connection**

*NOTE:* This step requires you to log in to Skype from a different computer or compatible mobile device.

1  Log in to your personal account (e.g. Tom Smith).

2  The contact request from your device’s Skype account should appear in the left column under Recent. Click the Skype account name for your device.

3  Click Accept.

4  Click the 📺 (Make a Voice Call) button to call your camera. The video call begins automatically. Please allow around 15 to 25 seconds for the video connection to be established.
   - You can also call the camera from the contact list using the Call button. Do not use the Video Call (🎥) button.
   *NOTE:* Video may appear pixelated immediately after connecting. It should improve within a few seconds, depending on your Internet connection.
If you do not have a Skype account...
Create your personal account first (e.g. Tom Smith), then create a second account for your camera (e.g. Lorex Camera).

Create a personal account (i.e. Tom Smith):
1. Go to www.skype.com, and click on **Join Skype**.

2. Click **Create an Account**. Fill in the appropriate fields.

3. Click the **I Agree - Continue** button.

4. Follow the on-screen instructions to download and install Skype on your computer.

5. Once you are logged in to Skype, click on **Skype > Sign out** (PC) or **File > Sign out** (Mac), then see “If you have an existing Skype account (PC)” on page 27 or see “If you have an existing Skype account (Mac)” on page 33.
### My Skype Account Information

<table>
<thead>
<tr>
<th>&quot;Personal&quot; Skype account</th>
<th>&quot;Camera&quot; Skype account</th>
</tr>
</thead>
<tbody>
<tr>
<td>(e.g. Tom Smith)</td>
<td>(e.g. Lorex Camera)</td>
</tr>
</tbody>
</table>

- **Skype Name:**
- **Password:**
- **Email address used to register this account** (used for account retrieval):

---

### Changing the camera view on Skype

**NOTE:** This section is applicable only if you have more than 1 camera.

You cannot change the camera or control the camera angle on the pan/tilt camera remotely using Skype; however, you can change the channel manually using the video monitor.

**Pair the camera that is most important for you to view remotely to Channel 1.** When you connect the USB cable to the video monitor, the video monitor defaults to Camera 1, even if you have a different channel selected.

**To change the camera view:**
- From your video monitor, press **CAM** to change cameras.
- The camera number changes to the next connected camera.

---

**NOTE:** You can only view one camera at a time.
Viewing your Camera Remotely Using Skype

Viewing a camera on your mobile device
You can remotely monitor your camera using Skype on supported mobile devices.

Supported apps & devices
• Skype for iPhone v. 3.0 and above
• Skype for iPad v. 3.5 and above
• iPhone 4S/4/3GS, iPad (1st generation and above), iPod touch (3rd generation and above)
• iOS 4.0 and above
For the latest device compatibility list, visit www.lorextechnology.com

Prerequisites
• Install and configure the PC/Mac Skype software and USB drivers. For details, see “Viewing your Camera Remotely Using Skype” on page 25.
• Ensure you configure your camera’s Skype account to auto-accept incoming calls.
• Ensure your personal Skype account has been added to the contact list for the video monitor’s Skype account.
• Ensure the video monitor is connected to your computer with the USB cable.

Viewing your camera on iPhone
1 Download and install the Skype application from the App Store.
   **NOTE:** Skype is a free application, but it requires a valid iTunes account to download.

2 Launch Skype and sign in using your personal account. Your contact list opens to All Contacts. If a different contact list is open, tap Contacts and then tap All Contacts.

3 Select the video monitor’s account, and tap Voice Call to connect to the camera. The video call connects automatically. Please allow 15 to 25 seconds for the call to connect.
   **NOTE:** Video may appear pixelated immediately after connecting. It should improve within a few seconds, depending on your Internet connection.
Viewing your camera on iPad

1. Download and install the *Skype for iPad* application from the App Store.  
   **NOTE:** Skype for iPad is a free application, but it requires a valid iTunes account to download.

2. Launch Skype and sign in using your personal account. Your contact list opens to All Contacts. If a different contact list is open, tap **Lists** and then tap **All Contacts**.

3. Select the video monitor’s account, and tap **Voice Call** to connect to the camera. The video call connects automatically. Please allow 15 to 25 seconds for the call to connect.  
   **NOTE:** Video may appear pixelated immediately after connecting. It should improve within a few seconds, depending on your Internet connection.
Installing Camera Batteries (LW2401 Camera Only)

The camera base has a built-in battery compartment where you can install rechargeable and non-rechargeable batteries. This can be useful if you want to temporarily monitor an area with no power outlets.

Installing non-rechargeable AA batteries
You can install regular AA Alkaline batteries (non-rechargeable) into the camera’s battery compartment.

To install regular AA batteries in the camera:
1 Unplug the power cord from the base of the camera.
2 Remove the battery cover.
3 Insert four AA batteries into the battery compartment and replace the battery cover.

Installing a rechargeable battery pack
Optional rechargeable battery packs are available from www.lorextechnology.com (part # ACC2401BATT). Regular rechargeable batteries cannot be charged in the camera base.

To install the rechargeable battery pack:
1 Remove the battery cover and insert the rechargeable battery pack in the battery compartment. Replace the battery cover.
2 Plug the power adapter into a power outlet. Connect the end of the power adapter into the camera base. Allow the camera to charge for 6 hours.

NOTE: The Charge LED indicator glows to indicate the battery is charging.
## Technical Specifications

### LW2401 Camera Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2400–2483.5Mhz</td>
</tr>
<tr>
<td>Maximum Range</td>
<td>450 ft. (138m) outdoor / 150 ft. (46m) indoor line of sight</td>
</tr>
<tr>
<td>Image Sensor</td>
<td>1/5” CMOS sensor</td>
</tr>
<tr>
<td>IR LED</td>
<td>8 Pcs.</td>
</tr>
<tr>
<td>Power Adapter Voltage</td>
<td>5V 1A</td>
</tr>
<tr>
<td>Battery Voltage</td>
<td>4xAA alkaline battery (not included) or 3.7V Li-Polymer battery (not included)</td>
</tr>
<tr>
<td>Battery Life</td>
<td>Up to 4 hours. Up to 2.5 hours with night vision on. Requires optional batteries.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>3.3in x 2.6in x 6in / 84mm x 67mm x 158mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.3 lbs / 0.14 kg</td>
</tr>
</tbody>
</table>

### Pan/Tilt Camera Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2400–2483.5Mhz</td>
</tr>
<tr>
<td>Maximum Range</td>
<td>450 ft. (138m) outdoor / 150 ft. (46m) indoor line of sight</td>
</tr>
<tr>
<td>Image Sensor</td>
<td>1/5” CMOS sensor</td>
</tr>
<tr>
<td>IR LED</td>
<td>8 Pcs.</td>
</tr>
<tr>
<td>Power Adapter Voltage</td>
<td>5V 1A</td>
</tr>
<tr>
<td>Dimensions</td>
<td>2.8in x 3.5in x 3.6in / 70mm x 90mm x 91mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.4lbs / 0.19 kg</td>
</tr>
</tbody>
</table>

### Video Monitor Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>2400–2483.5Mhz</td>
</tr>
<tr>
<td>Display size</td>
<td>3.5” TFT LCD</td>
</tr>
<tr>
<td>Power adapter voltage</td>
<td>5V 1A</td>
</tr>
<tr>
<td>Battery voltage</td>
<td>3.7V Li-Polymer battery (built-in)</td>
</tr>
<tr>
<td>Battery Life</td>
<td>Up to 4.5 hours</td>
</tr>
<tr>
<td>Dimensions</td>
<td>5.0in x 0.7in x 3in / 126mm x 17mm x 76mm</td>
</tr>
<tr>
<td>Weight</td>
<td>0.35lbs / 0.16kg</td>
</tr>
</tbody>
</table>
Cleaning and disposal

Cleaning
Clean the monitor and camera with a slightly damp cloth or an anti-static cloth. Never use cleaning agents or abrasive solvents.

- Do not clean any part of the product with cleaners with thinners or other solvents and chemicals. This may cause permanent damage to the product which is not covered by the Warranty. When necessary, clean it with a damp cloth.
- Keep your camera and monitor away from hot, humid, or wet areas or strong sunlight.
- Every effort has been made to ensure high standards of reliability for your video monitor. However, if something does go wrong, please do not try to repair it yourself. Contact Customer Service for assistance.

Disposal of the device
At the end of the product lifecycle, you should not dispose of this product with normal household waste, but take the product to a collection point for the recycling of electrical and electronic equipment. The symbol on the product, user’s guide and/or box indicates this.

Some of the product materials can be re-used if you take them to a recycling point. By reusing some parts or raw materials from used products you make an important contribution to the protection of the environment.

Please contact your local authorities in case you need more information on the collection points in your area. Dispose of the battery pack in an environmentally-friendly manner according to your local regulations.
Notices

**Warning:** Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the device.

**FCC notice**
This device complies with Part 15, subpart C, of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to this equipment. Such modifications could void the user’s authority to operate the equipment.

However, it is imperative that the user follows the guidelines in this manual to avoid improper usage which may result in damage to the unit, electrical shock and fire hazard injury. In order to improve the feature functions and quality of this product, the specifications are subject to change without notice from time to time.

**Caution:** To maintain compliance with the FCC’s RF exposure guidelines, place the camera at least 20cm (7.87in) from nearby persons.

**IC notice**
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux conditions suivantes: (1) l’appareil ne doit pas produire de brouillage, et (2) l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d’en compromettre le fonctionnement.

The Lorex Live Handheld Video Monitor models LW2401 and LW241 are in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Causes</th>
<th>Solution</th>
</tr>
</thead>
</table>
| No picture or sound on the Monitor     | • The monitor may be off.  
• The batteries on the camera or video monitor may be low.  
• The batteries may be installed backwards.  
• The monitor may be in Scan mode. | • Ensure that both the camera and monitor are turned on.  
• Ensure that both the camera and monitor are plugged in and fully charged  
• Double check that you have not inserted the rechargeable battery backwards.  
• Press the scan button to turn off Scan mode. |
| Monitor produces a high-pitched noise (squealing) | • The video monitor and camera are too close together.  
• The video monitor volume may be too loud. | • Move the camera and video monitor further apart.  
• Lower the video monitor volume. |
| Picture but no sound on the monitor    | • The volume on the video monitor may be too low.  
• The Auto-Mute feature may be enabled. | • Turn up the volume on the video monitor.  
• In the Main Menu select Auto-Mute, then turn the setting off. |
| Sound but no picture on monitor        | • The video monitor screen may be off. | • Press the Video button on the video monitor to turn the screen back on. |
| I get a "Out of Range" message on the monitor | • The video monitor lost connection with the camera.  
• The camera may be off.  
• [LW2401 only] The camera may be out of batteries. | • Move the video monitor and camera closer together.  
• Ensure the cameras are turned on.  
• [LW2401 only] Install fresh camera batteries. |
| Picture is not clear                   | • The video monitor and camera may have a weak signal.  
• Interference from the environment (from microwaves, wireless routers, etc.)  
• Brightness on the video monitor may be too low. | • Move monitor closer to the camera.  
• Move the monitor away from other wireless devices (e.g. wireless routers, cordless phones, walkie-talkies, etc).  
• Adjust the brightness on the video monitor. |
| The video monitor does not turn on     | • The video monitor may have low batteries. | • Connect a power adapter to the video monitor and a power outlet to charge the monitor. Charge the monitor for 4.5 hours. |
## Troubleshooting (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Causes</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Incorrect temperature reading | • The camera may be under direct sunlight.  
• Temperature sensor is accurate within 3°F/1°C.  
• Temperature setting on LW2401AC2 accessory camera is permanently set to 68°F/20°C. | • Move the camera to an area away from direct sunlight. |
| Missing recorded video files | • The Overwrite feature may be turned on. | • Turn the Overwrite feature off. For details, see “Configuring the Overwrite feature” on page 20. |
| I’m connected to Skype, but I don’t see any video | • The video monitor may be on the wrong channel.  
• The camera(s) may be off.  
• Handheld monitor may not be connected to computer.  
• USB drivers may not be installed.  
• USB port may be broken.  
• Auto-answer may not be enabled. | • Press right on the joystick to change to the correct channel.  
• Ensure the camera has power, and is turned on.  
• Launch Skype, then click Tools→Options→Video Settings. Ensure you can see the video on Skype  
• Ensure the handheld monitor is connected to the computer via the USB cable.  
• Insert the driver CD and install the USB driver.  
• Connect the video monitor to a different USB port.  
• For instructions on how to configure Skype to Auto-answer incoming calls, see page 29 for PC or page 34 for Mac. |
| I can’t see video on my mobile device | • Outdated version of Skype.  
• Camera drivers may not be installed.  
• Viewing on a non-supported mobile device. | • Install the latest version of Skype on your mobile device.  
• Ensure the camera drivers are installed from the CD.  
• Ensure the device is compatible with Skype. For a compatibility list, visit www.lorextechnology.com |
Frequently Asked Questions

**Q: I have Skype. Why do I need to create a Skype account for the video monitor?**

**A:** The video monitor requires a Skype account so you can access the camera(s) from your personal Skype account. Setup the video monitor for Skype viewing (for instructions, see "Viewing your Camera Remotely Using Skype” in the user’s guide). Then create a Skype account for the video monitor and add your personal Skype account to its Contacts. You access the camera by calling it - just like calling any one of your Skype contacts.

**Q: Why can’t I see an image from the camera(s) in Skype?**

**A:** Is this the first time you are setting up the video monitor for remote viewing? If so, follow the instructions in the "Viewing your Camera Remotely Using Skype” section of the user’s guide.

If you have already performed the initial setup, and still cannot access your camera(s) (or the video monitor appears as 'Offline'), check the following:

- Is the camera you want to view paired to Channel 1 or the channel selected on the video monitor?
- Is the handheld monitor connected to the computer?
- Are the camera and handheld monitor powered on?
- Is the computer powered on?
- Is the computer in Sleep mode or Hibernate mode? The video monitor will not be able to connect to Skype if the computer is in Sleep or Hibernate mode.
- Is Skype running on the computer and is the video monitor’s account signed in?
- Have you created a Skype account for the video monitor?
- Have you added your personal Skype account to the video monitor’s contact list?
- Do you have the latest version of Skype installed on your computer and/or mobile device?

**Q: What Skype app do I use to connect to the video monitor on my iPhone or iPad?**

**A:** For the iPhone, use the Skype app. For the iPad, use the Skype for iPad app. Both apps are available for free from the App Store.

**Q: How do I pair cameras?**

**A:** The camera included with your device has already been paired up with the handheld monitor. If for any reason your monitor and camera are not paired up, or you wish to add additional cameras, please perform the following:

1. Place the camera and video monitor 12 inches apart. Turn on the camera first and then the video monitor.
2. Press the **Menu** button on the monitor, then select **Pairing** and press the **OK** button.
3 Select an available channel, and press the **OK** button.
   **NOTE:** By default, the camera included with the system is paired to Channel 1.

4 Press the **PAIR** button behind the camera (LW2401 camera) or on the side of the pan/tilt camera within 30 seconds. You should immediately see video from the camera on the video monitor.
   **NOTE:** You can add a maximum of four (4) wireless cameras to the handheld monitor.
   **NOTE:** On the pan/tilt camera, you will need to use a pin or thin object to press the PAIR button.

**Q: How do I copy video to my computer?**

**A:** Remove the microSD card by using your finger-nail or other thin object to release the card. Insert the microSD card into the included SD card adapter and slide the notch to LOCK. Insert the SD card into your computer’s SD card reader. If your computer does not have a built-in SD card slot, you will have to purchase a separate SD card reader. Your computer (PC or Mac) should load the card like a standard drive. Copy or move the files from the SD card to a location on your hard disk.

**Q: Why is my picture at night time not as clear via Skype compared to my handheld monitor?**

**A:** Video is transmitted at a resolution of QVGA (320x240). When viewing on your computer, typically the viewing screen is larger than the handheld monitor, resulting in a stretched image to fit the screen-size. This is even more evident in night vision mode. In Skype, we recommended using “pop up mode” (image 1) for better clarity compared to default view (image 2).

**Q: Why is the temperature sensor giving me an inaccurate reading?**

**A:** Older versions of the LW2401 camera have a flexible temperature sensor. If it is placed too close to the camera, heat from the camera can be cause the temperature to appear higher than the actual temperature. The solution is to gently angle the sensor away from the body of the camera.

Newer versions of the LW2401 camera have a non-flexible temperature sensor that keeps the temperature sensor away from the camera to prevent inaccurate readings.

Make sure to keep the camera out of direct sunlight, as this may affect temperature readings.

**NOTE:** The LW2401AC2 accessory camera does not have a temperature sensor. When this camera is selected, the monitor will always show a temperature of 68°F/20°C.
Mounting Template (LW2401 Camera Only)

Use the mounting template to align mounting holes for your camera.